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Introduction

Photomatix Pro processes multiple photographs of a high contrast scene into a single image
with details in both highlights and shadows.

This manual offers step-by-step instructions for using the main features of the Photomatix Pro
software. The first section offers tips for taking photographs intended for High Dynamic Range
(HDR) processing. The second section describes how to create HDR images and process them
through tone mapping. The third section deals with the Exposure Blending functions, and the
fourth section with the Batch Processing tool. Finally, section five provides some advanced tips
and techniques for working with images in Photomatix Pro.

The following icons are used throughout the manual:
Y¥ Useful information and important notes.

[N Tips and recommendations.
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Workflow Shortcuts Panel

The functions of Photomatix Pro can be accessed via the menus. To allow faster access, some
core functions can be launched via the “Workflow Shortcuts” panel shown here:

(8] Workflow Shortcuts

Generate HDR image

Tone Mapping

Exposure Blending

Batch Processing

Tutorial

Workflow Shortcuts Panel

Drag & Drop

You can drag files from the Finder or other image browsers and drop them to the Photomatix
Pro icon on your Dock. If you drag & drop multiple image files, you will be able to access the
HDR creation or Exposure Blending processes.
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Section 1: Tips for Taking Successful Source Images

Section 1: Tips for taking photographs intended for HDR processing

Photographing a high contrast scene requires taking several exposures in order to capture
information in both the brightest highlights and deepest shadows of the scene.

Photographs can be made with digital or film-based cameras. The only requirement is that the
exposure can be adjusted when taking pictures. If you use a film-based camera, you will need to
scan them into your computer before processing them. Photomatix Pro can merge image files
saved in JPEG, 8-bit or 16-hit TIFF, and PSD formats. It also supports RAW files of several
camera models.

There are two general recommendations for creating differently exposed source images:

1) Make sure to take a sufficient number of exposures to properly cover the dynamic
range of the scene, from the darkest shadows to the brightest highlights.

2) Use a tripod whenever possible. Photomatix Pro incorporates Image Alignment
functions, but using a tripod is still recommended.

1.1 Automatic Exposure Bracketing (AEB)

= Shoot with available light whenever possible. The flash may try to balance the exposure
of all the images, when a range of exposures is the goal.

= Select a low ISO to minimize image noise.

= Select Continuous shooting mode on the camera'’s drive setting (Note: Continuous
shooting mode may not always be the best strategy because camera shake may build
up. We recommend using a method that ensures the least possible shake for each
single shot, e.g. mirror lock-up functionality, if available). Consult your camera manual
for model-specific instructions on using this setting.

» |f possible, use the camera’s self-timer setting, or a cable release to minimize camera
shake.

= Set your camera to Aperture priority (A setting) so that only the shutter speed varies
between the exposures.

» Set the camera to Auto Exposure Bracketing (AEB), which takes several photographs of
a scene in arow: one at the proper exposure, one or more underexposed, and one or
more overexposed.

0 Most cameras allow you to select the amount of over/under exposure in one-third
or one-half increments. The suggested exposure increment is +/- 2 for optimal
exposure range. If your camera does not offer +/- 2 exposure increments, select
the maximum possible. Consult the camera manual for model-specific
instructions on choosing this setting.
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Section 1: Tips for Taking Successful Source Images

AEB Settings on top LCD of a Nikon D80 (3 shots with +/- 2EV)

Rl [ [ =
AEB y T AR
Flash exp comp

WB SHIFT/BKT

Custom WB

Color space
Picture Style
Dust Delete Dat:

Canon Rebel XTi/400D LCD showing AEB with +/-2 increments selected.

0 Select an appropriate number of auto-bracketed frames if your camera offers
different options for the number of frames. For instance, if your camera can auto-
bracket at a maximum of +/- 1 EV increments, then select 5 or more frames if
your camera allows it. Five frames spaced by +/- 1 EV increments will give you
the same dynamic range coverage as three frames spaced by +/- 2 EV
increments.

= After capturing the bracketed images, check the histogram previews in playback
mode to ensure that you have captured an adequate range of exposures.

It is important to remember that the number of exposures needed depends on the dynamic
range of the scene, in addition to the exposure increment. For most outdoor scenes, three
exposures taken at +/- 2 exposure increment will be sufficient, provided the scene does not
include the sun. However, for the interior of a room with a bright view out of the window, you will
need at least five images taken with an exposure increment of +/- 2, or nine images taken with
an exposure increment of +/- 1.
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Section 1: Tips for Taking Successful Source Images

1.2 Manual Exposure Bracketing for DSLR cameras

In scenes with extreme differences between light and dark detail, manual exposure bracketing
over a greater exposure value range may provide better source images than Auto Exposure
Bracketing. t is the only option if your camera does not offer automatic bracketing over a wide
enough range to cover your scene. The following suggestions will help you to take optimal
pictures using manual exposure bracketing.

Choose a low ISO to minimize noise.

Keep a constant aperture and ISO. Control image exposure by changing the shutter
speed in full-stop increments. When taking pictures, use either the A or M setting,
Either of which will allow you to fix the aperture.

Shoot a series of images starting with your brightest image elements (highlights)
being slightly underexposed (see Figure 2.1 below) to the darkest image elements
(shadows) being slightly overexposed (see Figure 2.2 below). You may or may not
want or need to use every exposure in the series for HDR processing, but it is easier
to delete a picture at processing time than to return to a location to take additional
images. Experiment with different combinations of the bracketed source images in
Photomatix Pro to achieve your desired effect.

Check your DSLR's Histogram preview in playback mode to ensure that you have
captured the entire tonal range of the image. You should have at least one picture
without a large peak at the left side of the histogram and one picture without a large
peak at the right side of the image.

Use self-timer mode and mirror lock-up, or a cable release and mirror lock-up
options, if available. These will help minimize any camera shake, especially for
exposures slower than 1/15 second.

100-0363 Figure 2.1 Histogram depicts the brightest
elements (highlights) underexposed.

Adobe RGB
10/18/'06 21:29 i 00
1/8 3.5 &AM
36/48 G0+ AM1. 20w 1200
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Section 1: Tips for Taking Successful Source Images

100-0375 Figure 2.2 Histogram depicts the darkest

- Im image elements (shadows) overexposed.
Adobe RGB

10/18/'06 21:30 @ oo
30" 3.5 BM
48/48 {0+ AM3. 43we EI200

1.2.1 Manual Exposure Bracketing with Compact Digital Cameras

Consult your camera’s user manual to determine if manual exposure is possible. If this is
possible, you can follow the steps for Manual Exposure Bracketing with a DSLR.

W If your compact camera does not have an AEB setting, or allow you to set the exposure
manually, you can use the exposure compensation setting to manually bracket. The series
below shows the same scene captured at -2, 0 and +2.

LCD display

1.3 Film photo techniques for creating HDR source images

= Follow the advice for shooting with a digital camera. Keep in mind that you will not have
the option of previewing the live histogram to determine your exposure range.

= Scan your film or slides, not prints. Photo labs will attempt to make the best print from
each of your source images, and you will not achieve good results scanning these for
HDR generation.

= Turn off your scanner's auto-exposure options. This allows you to manually control the
exposure.

» Make sure you select the Align images option in Photomatix Pro when combining your
images.
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Section 2: HDR Generation and Tone Mapping

Section 2: HDR Generation and Tone Mapping

Creating images that display the High Dynamic Range captured by photographs taken under
different exposure settings is a two-step process:

= The first step is to merge your differently exposed photographs into a single 32-bit
HDR image. Because of its high dynamic range, an HDR image will not display
properly on conventional monitors.

» Inthe second step, the HDR image is then processed, or ‘developed,’ via the Tone
Mapping tool. Tone Mapping will 'reveal' the dynamic range captured in the HDR
image and produce an image which can be properly displayed on conventional
monitors. This can then be properly printed.

Y% The order of files in a bracketing sequence does not matter. Photomatix Pro will
systematically sort the image files based on exposure information retrieved from the
EXIF data. It will use their relative brightness levels when the exposure information is not
available.

2.1 HDR Generation

The easiest way to start the generation of the HDR image is by dragging your bracketed images
that cover the desired exposure range to the Photomatix Pro icon. Then select the option
Generate HDR image

000
_;l! What would you like to do with the dragged files?
| f*) Generate an HDR image

-~

) o~
_ Blend exposures

Open the files only

Cancel ) ( oK )

Note: You can set a default behavior in Preferences if you do not
want this window to show when dragging multiple files.

As an alternative, you can also click on the Generate HDR Image button of the Workflow
Shortcuts, or go to the Process menu and select the Generate HDR item.
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Section 2: HDR Generation and Tone Mapping

The Generate HDR — Selecting source images window will display.

Generate HDR - Selecting source images

Select image files taken under different exposures.

Either navigate to the files via the "Browse..." button
or drag-and-drop the files from the Finder.

[ Browse... )
e

Remove...

|\‘ Cancel n,l |\‘ OK ﬁ,l

Click Browse. The Select differently exposed images window will display to allow you to select
the source images to be combined.

&) Select differently exposed images
-« = qm) Carnival_Mask 1 Q

i @ o exporzis |

>H

|

=

Highlight the images that you wish to use for HDR Generation. Then click on the Select button.
The selected image files will be listed on the Generate HDR - Selecting source images window.
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Section 2: HDR Generation and Tone Mapping

Generate HDR - Selecting source images

Select image files taken under different exposures.

Either navigate to the files via the "Browse..." button
or drag-and-drop the files from the Finder.

3 Browse... )
carnival_expo-2.jpg —

carnival_expo+2.jpg
carnival_expo0.jpg

Cancel ) €0k )

Y% Photomatix Pro can generate an HDR image from 8-bit, 16-bit and RAW source files.
Supported file types include JPEG, TIFF, PSD, DNG and RAW files from many camera

models. As the list of supported camera models often changes when a new sub-version
of Photomatix Pro is released, we suggest that you consult the Photomatix Pro FAQ on

the www.hdrsoft.com website to check whether your camera model is supported. If your
camera model is recent, you may have to upgrade to a new version, or wait till

Photomatix Pro adds support for it.

Click OK to proceed further.

< If the exposure information cannot be found in the metadata of the image files,
Photomatix will show a window where you can input the relative Exposure Values for
each one of your images. This window will also show if two or more source images

share the same exposure information.

The Generate HDR - Options window will appear.

(5] Generate HDR - Options

¥ Align source images | Don't crop
: By correcting horizontal and vertical shifts

@ By matching features

__ Attempt to reduce ghosting artifacts

Detection

’i‘ Take tone curve of color profile (recommended)
_ Attempt to reverse-engineer tone curve applied

_ No tone curve applied - pixel values are linear

'( .«infplﬂ ( 0K )

This window will display when the source images are JPEG, TIFF or PSD files. When they are
RAW files, a different window will be displayed (read more below).
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Section 2: HDR Generation and Tone Mapping

General settings for Generate HDR

Alignment settings

The Align source images option is checked by default. The Align images option corrects for
misalignment problems if the camera moved slightly between the bracketed frames. This is
the case with hand-held photographs, but may also happen when shooting with the aid of a
tripod.

Photomatix offers two alignment methods based on different algorithms. The first one By
correcting horizontal and vertical shifts is fast but corrects for translation movements only.
The second one By matching features corrects for both rotation and translation.

The Don't crop option is useful when the resulting images must have the same width and
height as the source images. As an example, Realviz Stitcher requires this of images it
processes.

Ghosting reduction settings

If the scene has moving objects and you find the resulting 'ghosts' are not desirable, then
check Attempt to reduce ghosting artifacts with the option Moving objects/people selected. If
there are elements in the scene that follow a rhythmic pattern (flowing water for instance)
oscillating between shadows and highlights, then select the option Background movements
instead. In both cases, first try leaving the Detection option set to Normal. If you find that the
resulting HDR image still shows too much ghosting, then try again with the option set to High.

Only check the Attempt to reduce ghosting artifacts box with the Moving objects/people
option if it is necessary. Checking them in other cases will lower the quality of the resulting
HDR image.

Generate HDR settings when the source images are JPEG, TIFF or PSD
files:

The recommended option Take tone curve of color profile is selected by default. This is usually
the best choice when the images files come from a DSLR camera or have been converted
from RAW files. This option loads the Tone Reproduction Curve data from the ICC color profile
associated with the source images in order to determine the non-linear function applied to the
raw sensors data. If no profile is available, it uses the tone reproduction curve of the Adobe
RGB color profile.

When the images are scanned films or taken with a compact camera, it may be worthwhile to
check the option Attempt to reverse-engineer tone curve applied.

If your source images are 16-bit TIFF files that have been converted from RAW files with a
special option in the RAW converter to leave the image in linear space, then check the option
No tone curve applied — pixel values are linear. Only check this option if you are 100% sure that
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Section 2: HDR Generation and Tone Mapping

the tonal values of the images are linear relative to the values of light captured. Please note that
the terminology linear may be used with a different meaning depending on the RAW converter
(in Adobe Camera RAW, for instance, linear is relative to the Adobe RGB color space and not to
the values of light).

Generate HDR settings when the source images are RAW files:
The Generate HDR - Options window will display with additional options:

(&) Generate HDR - Options

V! Align source images ! Don't crop
By correcting horizontal and vertical shifts

f,\ Ry matching features

__ Attempt to reduce ghosting artifacts

Detection

By default, Photomatix will use the As Shot
White Balance (read from the EXIF
metadata) when converting the RAW data to
HDR. You can adjust the White Balance by
selecting a pre-defined white balance from
the drop-down menu, or by specifying the

color temperature in Kelvin. A preview lets
you see the effect of the change on the
source image.

The RAW data is in a color space specific to
the camera. Photomatix will convert the data
into a standardized color space (by default
Adobe RGB). You can, however, select
sRGB or ProPhoto RGB instead.

Note: above curve options are grayed-out because RAW files do not
have a tone curve applied.

RAW conversion settings

White Balance As Shot )

Preview sample

Color primaries HDR based on: Adobe RGB 3]

Cancel ¢ ok )

It is important to note that the selected color space is used for the color primaries only, and not
for the tone reproduction curve. Since the HDR image values are in linear space, they do not
have a tone curve. The tone curve of the profile associated with the image will only be applied
during the tone mapping step, and not to the HDR image itself.

Once you are satisfied with the settings of the Generate HDR - Options window, click OK to
create the 32-bit HDR image.

A progress bar will display in the Generate HDR - Options window. Once the HDR is
generated, the HDR image and the HDR Viewer window will display on-screen.
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Section 2: HDR Generation and Tone Mapping

* Step one of the two-step process is how complete.

* Until Tone Mapping is applied, the 32-bit image seen on screen cannot display its full
tonal range.

* The small view on top of the “HDR viewer” window shows a local section of the HDR
image viewed at the appropriate exposure.

R Saving the 32-bit HDR image at this point will allow you to apply different Tone Mapping
settings to the HDR source image without repeatedly following the Generate HDR procedure.
Since version 3.0, Photomatix Pro saves the name of the color profile in the header of HDR
images saved in the Radiance (.hdr) format. This means you will not have to re-assign the color
profile, provided the HDR image file have been saved as Radiance and the color profile is either
sRGB, Adobe RGB or ProPhoto RGB. However, the color profile information of the source
images will not be preserved if the HDR image has been saved in the OpenEXR format.

Y¥ Photomatix Pro allows you to create a 32-bit HDR image from a single RAW file. To do
this, open one RAW file using File->Open, and Photomatix will convert it into a pseudo-
HDR image. It is important to note that an image created with a single RAW file cannot
really be considered High Dynamic Range. The important characteristic of this pseudo-
HDR image is that it is unprocessed. Its dynamic range is not much larger than the range
of an already converted file.
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Section 2: HDR Generation and Tone Mapping

2.2 Tone Mapping

The generated HDR image cannot be represented properly on screen without further
processing. An unprocessed HDR image is somewhat similar to a film negative or the RAW file
of a digital camera. It needs further processing for display or printing. In Photomatix Pro, this
processing is called Tone Mapping.

There are two tone mapping methods for processing the HDR image: Details Enhancer and
Tone Compressor.

2.2.1 Tone Mapping with Details Enhancer

Photomatix Pro defaults to this option when the Tone Mapping window is opened. Details
Enhancer utilizes a local operator to ‘develop’ the HDR image. This means that it takes into
account the local brightness context -- a pixel of a given value in the HDR image will be mapped
differently depending on whether it is located in a bright or dark area of the image.

Click on the Tone Mapping button on either the HDR Viewer window, the Workflow Shortcuts
window or the Process>Tone Mapping menu to launch the Tone Mapping tool for the active
open HDR image. If you have used the Generate HDR process to create a new HDR source
image, it will be the active image. Otherwise, open a saved HDR image file via the File>Open
menu.

Use the slider controls to adjust the image. The preview on the right provides an approximation
of what the image will look like once Details Enhancer is applied to the entire HDR source
image. In the case of the Details Enhancer tone mapping method, the preview is not always an
accurate representation of the final tone mapped image.

(s] Tone Mapping Settings - IEQ0B__ | () 1) 1) Tone Mapping Preview - JE008651.2.3
- I S ~ o) ~ s =
Deralis Enhancers Tone Compeessor }\ | () small O Medium (@ Large O Fit Shuw Original  Refresh foupe only

Strength 38
e

Color Saturation 57
—_— N

Light Smaothing igh
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Section 2: HDR Generation and Tone Mapping

Details Enhancer incorporates the following image adjustment sliders:

(6] Tone Mapping Serttings - JEOOS..

{ Details Enhancer | Tone Compressor

General adjustments

Strength
&

Color Saturation

>

38

wn
~

Light Smoothing

Luminosity

High

’ Tone | Color  Micro

S5/H

White Point

0.700

Black Point
AL

0.000

Gamima
raY

' 360" image

Reset Default

Presets Previous

Process

Undo  Redo
.

:)

{ Tone

Color

Strength: Controls the strength of contrast enhancements. A value of
100 gives the maximum increase in both local and global contrast

enhancements.

Color Saturation: Controls the saturation of the RGB color channels.
The greater the saturation, the more intense the color. A value of zero
produces a grayscale image. The value affects each color channel

equally.

Light Smoothing: Controls smoothing of contrast variations throughout
the image. A higher value tends to reduce halos and give a more
natural look to the resulting image. A lower value tends to increase

sharpness.

Luminosity: Controls the compression of the tonal range, which has

the effect of adjusting the global luminosity level. Moving the slider to

the right has the effect of boosting shadow details and brightening the
image. Moving it to the left gives a more natural look to the resulting

image.

Micro I S/H

White Point
A\

0.024

Black Point

A

' 0.000

Camma

Tone adjustments

White Point - Black Point: Both sliders control how
the minimum and maximum values of the tone mapped
image are set. Moving the sliders to the right increases
global contrast. Moving them to the left reduces
clipping at the extremes. The White Point slider sets
the value for the maximum of the tone mapped image
(pure white or level 255). The Black Point slider sets
the value for the minimum of the tone mapped image
(pure black or level 0).

Gamma: adjusts the mid-tone of the tone mapped
image, brightening or darkening the image globally.

Photomatix Pro User Manual
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Section 2: HDR Generation and Tone Mapping

S— — Color adjustments
Tone | Color | Micro S/H

Color Temperature: Adjusts the color temperature of
the tone mapped image relative to the temperature of
the HDR source image. Moving the slider to the right

TREpEALTe 0 will give a “warmer”, more yellow-orange colored look.
- A Moving the slider to the left gives a “colder” more
bluish look. A value of zero will preserve the original
Saturation Highlights - g color temperature of the HDR source image.
P Saturation Highlights: Adjusts the color saturation of
= the highlights relative to the color saturation set with
: 1 the Color Saturation slider. Values higher than zero
Saturation Shadows 0 . o A i
increase the color saturation in the highlights; values
- A lower than zero decrease it.

Saturation Shadows: Adjusts the color saturation of
the shadows relative to the color saturation set with the Color Saturation slider. Values higher
than zero will increase the color saturation in the shadows. Values lower than zero will decrease
it.

Tone  Color |~ Micro | S/H Micro adjustments
Micro contrast: Sets the level of accentuation of local
details.
Microcontrast R +5 Micro-smoothing: Smoothes out local detail
/;\ enhancements. This has the effect of reducing noise
in the sky for instance, and tends to give a "cleaner”
Micro-smoothing 7 look to the resulting image.

ray

V¢ Important note: The Loupe may not properly show

the effect of the Micro-smoothing setting when the area

magnified is uniform. If you want to see the effect of the

micro-smoothing setting at 100% resolution on a uniform

area such as the sky, you will have to select an area that
contains an object in the scene in addition to the sky.
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Section 2: HDR Generation and Tone Mapping

'Tone [ Color I Micro S/H ’

Highlights Smoothing 22
ras

Shadows Smoothing 0

A

Shadows Clipping | 0

A R

Shadows/Highlights adjustments

Highlights Smoothing: Reduces the contrast
enhancements in the highlights. The value of the
slider sets how much of the highlights range is
affected. This control is useful to prevent white
highlights from turning grey, or uniform light blue
skies becoming dark blue-grey. It is also useful
reducing halos around objects placed against bright
backgrounds.

Shadows Smoothing: Reduces the contrast
enhancements in the shadows. The value of the
slider sets how much of the shadows range is
affected.

Shadows Clipping: The value of the slider sets

how much of the shadows range is clipped. This control is useful to cut out noise in the
dark area of a photo taken under low-light situation.

Other setting

360° image: This option needs to be checked when the image processed is an equi-
rectangular image intended to be viewed as a 360° panorama. This is because Details
Enhancer takes into account local contrast and will assign different tonal values to the
360° seams of the panorama. This will produce a visible seam once the resulting image
is rendered in a panorama viewer. Checking this option corrects for this.

= The 360° image option should only be checked for equi-rectangular 360°
images. Checking it in other cases may produce less optimal results.

= Checking the 360° image option increases the amount of memory necessary
to process the image by more than 50%. Processing times will also be

increased.

Once you are satisfied with the results of the Details Enhancer adjustments Click Process to

create the tone mapped image.

Photomatix Pro User Manual
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Section 2: HDR Generation and Tone Mapping

oRalal carnival_expo-2_+2_0_tonemapped @ 19%

¥¢ Edit>Undo Tone Mapping will undo the tone mapping settings applied to the original
HDR image. The tone-mapped image will revert to a 32-bit HDR image, which can then be
tone mapped again.

The resulting tone mapped image always has a bit depth of 16 bits/channel. This is even
the case if the source images were JPEGs or 8-bit TIFF files.

Saving the tone mapped image

Save the resulting file using the File>Save As menu. .

TIFF — 16bit: Best choice for further processing

T.IFF — 8bit: For use in applications that cannot deal with 16
?E’EG: For use on the web without further editing

File Formafe it G B G FUL TN

TIFF - 8 hits/channel
( New Folder ) IPEG

Process>Save settings will save the applied tone mapping settings as an .xmp file so you can
easily reproduce the same Tone Mapping process in the future.
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Section 2: HDR Generation and Tone Mapping

¥¢ If you open a large HDR file (larger than the threshold set in preferences, by default
30 Megapixels) the following window will show:

This image file has a size of 37 MegaPixels.

1
; ‘ For faster processing and to avoid potential memory issues,
I you can choose to open this image in preview mode instead
of loading it entirely in memory. In preview mode, you will
still be able to tone map the entire image, but not to view it
at 100% resolution.

Do you want to open the image in preview mode?

Note: You can adjust in Preferences the image resolution that triggers this window.

If you click yes the HDR file will be opened in preview. You will get the same tone
mapping window and the preview as shown above. The only difference is that you cannot
view the file at 100% in the Loupe. The same dialog shows for both Tone Mapping
methods.

The Tone Mapping window offers additional settings, which are explained after ‘Tone
Mapping with Tone Compressor’ instructions.

In the example above, the HDR image was generated from these three source images.
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Section 2: HDR Generation and Tone Mapping

2.2.2 Tone Mapping with Tone Compressor

From the Tone Mapping window, select the Tone Compressor tab.

Use the slider controls to adjust the image. The preview on the right provides a view of what the
image will look like once Tone Compressor is applied to the entire HDR source image.

Tone Mapping Settings - JE0OS.. Tone Mapping Preview = JECO8651_2_3

Detas Enhancer [“Tone Compressor ) = cmai O Medium © large O Rt { Show Original )

Brightness 6
—_— A

Tonal Range Compression E)
— D

Contrast Adaptation 1

of . _a0n.

White Paint $.40%

Black Point 0.00%

Color Temperature 0

Color Saturation +2
—_— e

Reset: [ Default ) &

Undo Redo

Presets: | Custom )
C——Se—)
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Tone Compressor incorporates the following image adjustment sliders:

Details Enhancer = Tone Compressor |

Brightness [ 6] Brightness: Influences the tone mapping process done on the HDR
A image in regards to overall image brightness.

it Gl Ll Tonal Range Compression: Controls how the tonal range of the 32-
- bit image is compressed into the 0-256 range of 8-bit monitors. The
Sonmas omanon ! higher the value, the more both shadows and highlights will be

O

shifted toward the center of the histogram. The Tone Compressor
tone mapping method ignores local context.

Contrast Adaptation: Sets how much the contrast is adapted to the

- I intensity of the pixel values processed.

White Point - Black Point: Both sliders control how the minimum

White Point 5.40%] and maximum values of the tone mapped image are set. Moving the
A sliders to the right increases global contrast. Moving them to the left
Black Point "0.00%] reduces clipping at the extremes. The White Clip slider sets the value
& - for the maximum (pure white or level 255). The Black Clip slider sets
the value for the minimum (pure black or level 0).
i hadl T g Color Temperature: Adjusts the color temperature of the tone
= mapped image relative to the temperature of the HDR source image.
g Y ? Moving the slider to the right gives a “warmer”, more yellow-orange

colored look. Moving the slider to the left gives a “colder” more bluish
et oy € look. A value of zero preserves the original color temperature of the
* Undo Redo HDR source image.

Presets: Custom &

Color Saturation: Adjusts the color saturation of the tone mapped
€  Poess )  image. The greater the saturation, the more intense the color. The
value affects each color channel equally.

Once you are satisfied with the results of the Tone Compressor adjustments click Process to
create the tone mapped image.
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Y¥¢  Edit>Undo Tone Mapping will undo the tone mapping settings applied to the original HDR
image. The tone mapped image will revert to a 32-bit HDR image which can then be tone
mapped again.

Saving the tone mapped image

Save the resultant file using the File>Save As menu (you have the same options as shown in
the previous section on Details Enhancer).

Process>Save settings will save the applied tone mapping settings as an .xmp file so you can
easily reproduce the same Tone Mapping process in the future.

Additional Tone Mapping Settings

In addition to the image adjustment controls, the Tone Mapping Settings and Preview windows
include several other options and settings, which apply to both the Details Enhancer and Tone
Compressor methods.

Preview: Photomatix Pro offers four preview sizes: small, medium, large and fit. Select
the radio button for desired size.

® Click the mouse on the preview to zoom in to 100% magnification. Click the mouse
again to return to full image preview.

s Eoaand B Reset, Undo & Redo: Reset lets you change the values to the
- Undo Redo Photomatix default values. Undo (arrow to the left) and Redo
Presets: | Custom [#)  (arrow to the right) allow for quick switching between the current

and previous settings done in the Tone Mapping window.
— Tone Mapping Presets
Reset Nefault . . .
Default i Photomatix allows you to store settings for use at a later time.
Presets v Previous D

e Default: Default settings. Same as the “Default” button.

Previous: Recalls settings used the last time you used the
tone mapping tool.

Save Settings...
- Delete Settings... . List of saved presets: e.g. here “carnival_manual’, which had
been saved during a previous session using “Save Settings”

Load Settings...

Load Settings..: Load settings previously saved via “Save Settings” as XMP file outside of the
Presets folder.

Save Settings..: Save settings either in the Presets folder or elsewhere. When they are saved
in the Presets folder, they will show in the list of Preset for quick access.

Delete Settings..: Delete presets that are not needed anymore.
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Inspecting the preview with the Loupe tool

7. Tone Mapping Preview - JEOO8651_2_3.hdr

Fit Show Original ! Refresh loupe only

.| Loupe - JEOO8651_2_3.hdr

Note: With the Details Enhancer method, the loupe only shows the level of
details enhancements. Showing the correct brightness requires processing
the entire image.

Loupe shows 100% pixel view

Both Tone Mapping methods feature a Loupe panel so that you can inspect fine details in your
image. If you move the mouse over the preview you see a square marquee. If you click at some
position the content of that square will show up in the Loupe panel.

¥ The option Refresh loupe only can be used to avoid refreshing the main preview when you
change settings. This will speed up the view refresh inside the loupe window.
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R If you save the tone mapped image as a TIFF file, the tone mapping settings will be
automatically embedded as XMP metadata in the TIFF file. If you open the file in
Photoshop, you can then view the tone mapping settings under File->Info->Advanced.

Photoshop m Edn  mage Layer Select Fiter View Window Help 3 LR
L » P8 TR Sovte | et W -

o = ” 1 ' 4

[Noas emsmmmmwme s ST i D

Venice-Nash_Exgo-24+ 280 14

pentm Srength: 37

pentm ColorSaturaon. 42

THY Properties (Y, Bitp [ /ns sdobe.com /t¥) 1.0,

EXF Properties (exd. hmp /) ns adebe comiexd /1.0

XD Nedia Nanagemens Properties (ampMM, hatp //ns. adobe com)xap/ § O/mm/)
XM Core Prope 0

>
>

>

> mp, b
» Dublis Core Py

>

>

>

Adobe Mce
FOF Preperties

g/ s adebe com/peg /1.0

XxXmp Replace Append Save
Cancel ——on——)
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Section 3: Exposure Blending

In addition to the two-step HDR processing described in the previous pages, Photomatix Pro
also offers several single-step exposure blending methods. These will combine differently
exposed images to show detail in both shadows and highlights.

= These blending methods combine differently exposed photographs into a single image. It
uses the existing shadow and highlight detail from the source images to make a single
final ‘blended’ image with an expanded tonal range.

Exposure Blending offers several advantages over the HDR and Tone Mapping workflow
described in the previous section:

* Blending the images has the effect of reducing noise whereas HDR and tone
mapping amplify it.

* The blended image does not differ much from the source images, giving it a more
natural look.

* Exposure Blending is a simple and easy to understand process, with no or few
parameter settings.

Exposure Blending may not always work well when the dynamic range of the scene is high. This
can result in a lack of local contrast and a "flat” look. The memory required for blending
exposures increases with the number of source images and bit-depth.
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3.1 Blending Exposures

To start Exposure Blending, drag your images to the Photomatix Pro icon, and select the option
Blend exposures

ene

— ?'l What would you like to do with the dragged files?
¥ | ) Generate an HDR image
'vl ¥ ~
= o) Blend exposures

) Open the files only

[ Cancel '( OK )

Note: You can set a default behavior in Preferences if you do not
want this window to show when dragging multiple files.

Alternatively, you can also click on the Exposure Blending button of the Workflow Shortcuts, or
go to the Process menu and select the Exposure Blending item.

The Exposure Blending — Select source images window will display. Load your images via the
Browse button (not needed if you use drag & drop).

Exposure Blending - Selecting source images

Select image files taken under different exposures.

Either navigate to the files via the "Browse..." button
or drag-and-drop the files from the Finder.

= r | Browse...
carnival_expo0.jpg —

carnival_expo-2.jpg
carnival_expo+2.jpg

@ Align source images
" By correcting horizontal and vertical shifts

® By matching features

[ Cancel ) ( OK )

The Align Source images option is checked by default. This option corrects for misalignment
problems if the camera moved slightly between the bracketed frames. This is the case with
hand-held photographs and may happen when shooting with the aid of a tripod.
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Click on OK and the Exposure Blending dialog will show.

8606 " camival_expo0_-2_+2

O Avarage
Highlights & Shadows - Auto

) Highlights & Shadows - Adjust

_ Highlights & Shadows -2 images

{_ Highlights & Shadows « Intensive

Estimaced processing time: O m. 34 5

(- Process > )

Select the Exposure Blending method of your choice. Some methods allow settings and some
are fully automatic. Try different methods to get the most pleasing results. The default method
Highlights & Shadows — Adjust is often a good choice.

3.1.1 Highlights & Shadows — Adjust

Adjust the settings sliders

Strength 0
R NSRS RSN Strength: Controls the strength of local contrast
enhancements.

Color Saturation 1 . . .

N e e Color Saturation: Allows the increase or decrease of image
= saturation.

lending Poi . . _— .

B‘e". s PP'"L\, = it Blending Point: Controls the weighting given to the source

e SRR images. When moving this slider to the right, the over-exposed

images are favored This has the effect of brightening the
image. The reverse applies when moving the slider to the left.

3.1.2 Highlights & Shadows — Auto

This blending method is automatic. If you like the result, you are done. Otherwise, try one of the
manual options.
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3.1.3 Highlights & Shadows — 2 Images

This method blends only two images. The displayed dialog

Fitst image_ allows you to select which images get blended.

-m carnival_expo0
' carnival_expo+2

Second image

carnival_expo-2
n carnival_expo+2

3.1.4 Highlights & Shadows — Intensive

Strength: Controls the strength of local contrast enhancements.

Strength | 0 i i i
= Color Saturation: Allows the increase or decrease of image
= — saturation.
Color Saturation 0 . . .
o Radius: Controls the area used to calculate the weighting of the
- source images. A higher radius reduces halos, but increases
Radius 40 processing times significantly.
O

3.1.5 Average

The Average method combines the images using the same average formula everywhere,
regardless of whether the processed pixels is in a dark or bright area. This is why averaging can
not produce the dynamic range extension you can get with one of the Highlights & Shadows
blending methods. The Average method offers better noise reduction (it is equivalent to the
process called Image Stacking).
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Click Process. Photomatix Pro will create an Exposure Blended image.

806 — § carnival_expod_-2_+ 2 adyust @ 37%

Highlight & Shadows — Adjust: Resultig blended image

Save the processed file using the File>Save As menu.

[N ur v TIFF = 16 bits/channel
TIFF - 8 bits/channel
( New Folder ) JPEG

Available file formats

The TIFF 16-bit option is only available if the source images were also 16 bits/channel.
Exposure Blending does not change the channel bit-depth. The resulting image will have
the same channel bit-depth as the source images.
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Inspecting the preview with the Loupe tool

"] Refresh loupe only

Loupe - JEOO8651_2_3

Loupe shows 100% pixel view

Exposure Blending features a Loupe panel so that you can inspect fine details in your image.
Moving the mouse over the preview displays a square marquee. If you click at some position,
the content of that square will show up in the Loupe panel.

¥¢  The option Refresh loupe only can be used to avoid refreshing the main preview when
you change settings. This speeds up the refreshing of the view inside the loupe window.
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Section 4: Automate

Photomatix supports two different batch process functions:

= Batch Processing: Processes multiple photos taken at different exposures
= Single File Conversion: Processes single image files

Batch Processing may be used to:

» Process an exposure series to create HDR image files ready to be tone mapped
individually. If you open another session of Photomatix Pro, you can start working on
the first images while Batch Processing is still processing the remaining exposure
series.

= Apply several different tone mapping or exposure blending methods to one set of
source images.

= Apply the same tone mapping or exposure blending settings to several different sets
of source images.

= Apply both of the above processes at once: applying many different tone mapping or
exposure blending methods to several sets of source images.
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4.1 Batch Processing

Click on the Automate menu and select Batch Processing or use the Batch Processing button
on the Workflow Shortcuts panel.

e Batch Processing of differently exposed images
PROCESS ——
3 : Close ) Run

¥ Generate HDR image Settings...

# Process with Details Enhancer " Settings... |

_ Process with Tone Compressor
__ Average
__ Highlights & Shadows - Auto
# Highlights & Shadows - Adjust { Settings... |
" Highlights & Shadows - Intensive
Select 3 ?} images at a time
{number of images combined together - files are selected alphabetically)
@Align images ! Don't crop

) By correcting horizontal and vertical shifts

By matching features
SOLRCF NFSTINATION
Selection by ) Folder [ )

~ S : w @ Created under Source Folder
_ Individual files =
: Customized location ‘ Choose... )
CA_0712D300_0405.tif hr—
CA_0712D300_0406.tif
CA_0712D300_0407.tif
NOCA_0712D300_0405.tif Save as: | JPEG 79)  JPEG Quality: (100 1%
NOCA_0712D300_0406.tif a
NOCA 07120200 NANT tif X Save HDR image as:  Radiance RGBE (.hdr) | :J
= | Remove HDR image after processing
Filter by =~ Al 3)

|_| Process subfolders _Naming options...

Y€  The batch can process sub-folders with different numbers of source images in
each folder.

R It is important to note that when you are processing different sets of source images in
a single folder, each set must contain the same number of source images. If each set

contains a different number of source images, you will need to place them into separate
folders and select the All option for the number of files to process.

4.1.1 Batch Processing Settings

Select the processes to be automated. At least one option described below (Options A-G) must
be selected to run the Batch Processing.

Option A: Generate HDR image
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Check this option if you want to create a 32-bit HDR image. Click the Settings button to open an

option window.

Force Exposure Values spacing to 2 —-‘

Attempt to reduce ghosting artifacts

® Moving objects/people
= Detection
_ Background movement

Source images are linear (no tone curve applied)

When source images are in RAW format

White Balance: As Shot I's ’

Preview sample |

Color primaries HDR based on: Adobe RGB T'

When source images are in TIFF format

__| Process strip by strip (to avoid memory limitations)

f OK )

The first checkbox will force the EV spacing to
the specified value. This option can be used
when the exposure information is not available
in the EXIF data (or if two or more images have
the same exposure information), or to force the
EV spacing in all cases. In the latter case, the
exposure information in the EXIF data will be
ignored.

If there are moving objects in the source
images and you find the resulting 'ghosts’ are
not desirable, check Attempt to reduce
ghosting artifacts with the option Moving
objects/people selected. If there are elements
in the scene that follow a rhythmic pattern
(flowing water for instance) oscillating between
shadows and highlights, then select the option
Background movement.

Only check the Attempt to reduce ghosting
artifacts option if it is needed.

If the source images are large TIFF files, check the option Process strip by strip. With this
option, the HDR image file will be created in several passes, processing and loading only one
strip of each image into memory at a time. One strip is composed of a limited number of rows
set to not exceed around 512 MB of RAM. This option is particularly useful when processing

large panoramas.

If the source images are RAW files, White Balance and Color Primaries may be selected.
Please refer to the HDR Generation chapter of section 2 for details on those settings.
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Option B: Process with Details Enhancer

Check this option if you want to automatically tone map the HDR image with the Details
Enhancer method. Click the Settings button to open a window which allows the adjustment of
the Details Enhancer settings (described in Section 2). You may load settings, which were
saved in an XMP file in this window.

When the option Save is checked, the settings will be saved in an XMP file alongside the tone
mapped images. This option is checked by default.

Strength 38
N
Color Saturation 57
PN
Light Smoothing it
S s = ® S
Luminosity >7704
s

LTone { Color VM’icro S/H

White Point " 0.700
YA

Black Paint '~ 0.000

A

Gamma T 0.96
A

Settings

- Previous ~ Load...

* Default gSave
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Option C: Process with Tone Compressor

Check this option is you want to automatically tone-map the HDR image with the Tone
Compressor method. Click the Settings button to open a window that allows the adjustment of
the Tone Compressor settings (described in Section 2). You may load settings that were saved
in an XMP file in this window.

Brightness 6
O\
Tonal Range Compression 7
O\
Light Smoothing High
Contrast Adaptation 7 ' 1‘
Py

L

! Tone Color [ Micro ' S/H

White Point 0.250
T
Black Point " 0.000
A
Settings
* Previous | * Load... |
© Default ) ™ Save
€ ox )

R Batch Processing lets you tone map your HDR images with Details Enhancer and
Tone Compressor simultaneously.
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Option D: Average

Check this option if you want to combine the source images using the average method. There
are no other options available.

Option E: Highlights & Shadows — Auto

Check this option if you want to combine the source images with the exposure blending method
Highlights & Shadows — Auto. There are no other options available.

Option F: Highlights & Shadows — Adjust

Check this option if you want to combine the source images with the exposure blending method

Highlights & Shadows — Adjust. Click the Settings button to open a window to adjust the
Strength, Color Saturation and Blending Point.

Strength 0
A

Color Saturation 0
ey

Blending Point 0
P

<< darker - brighter >>

( OK ;

Option G: Highlights & Shadows — Intensive

Check this option if you want to combine the source images with the exposure blending method
Highlights & Shadows — Intensive.

Strength 0
Py

Color Saturation 0
Pt

Radius 40
Ay

f OK )

Photomatix Pro User Manual Page 33



Section 4: Batch Processing

Number of Source Images to process
Select the number of source images to process at a time: 2-11 or All.

All should only be selected if you are using the Process Subfolders option, or if the folder
processed contains only one set of bracketed exposures. When All is selected, Photomatix will
attempt to process all images in each folder, so it is important that only one set of source
images be in each subfolder.

¥ It is possible to Batch Process multiple series of source images with varying numbers
of source images, if each series is in its own subfolder, and All is selected.

Y¢  If all source images from multiple series are in a single folder, each series must
have the same number of source images. Images are processed alphabetically.

Image Alignment Options

Check Align Images, if correction for slight camera movements between source photographs is
needed.

When Align images is checked, the images will be cropped after alignment in order to remove
invalid areas on the edge due to the correction for misalignment shifts. If you want to skip the
cropping, then check the Don't crop option. This option may be useful if you are processing
images intended to be stitched together to create a panorama.

Select a source location
Photomatix allows multiple ways to select source images.

= By Folder: Click on the Select Source Folder button and select a folder with images
to process. All images in that folder will show up in the file list.

= By individual files: In this single files can be added to the file list.

In the case when Folder is selected, the Process subfolders option may be checked.
This option offers two sub-options.

0 Sequentially: Processes the image files in one sub-folder, then moves on to the
next sub-folder, all of which are contained in the main, parent folder.

0 Grouped by Exposures: In this case the sub-folders are organized by
exposures. As an example, if you have taken a series of three bracketed images,
one sub-folder contains all underexposed images, the next all normal exposed
images and the third one all overexposed images. Inside a sub-folder, the images
that belong to one image group (to be merged) need to be at the same relative
alphabetical position inside the sub-folder.

R Use Process Subfolders if you have multiple series of source images which vary in
the number of source images they contain. The Batch Processing can process series
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with varying numbers of source images if each series is in its own subfolder and All is
selected.

Select a file type from the Filter by File Type dropdown. Options are: All, TIFF, JPEG, PSD and
RAW.

® This option is useful if a source folder contains RAW+JPEG from a camera, and you
are processing only one file type.

Select a Destination location

By default, Same as source is selected. With this option, the Batch Processing will save the
resulting images in a subfolder within the source folder. The resulting folder will be prefixed by
‘PhotomatixResult’. Checking Select allows you to select a specific (different) location on your
computer.

Select a file type for saving (JPEG or TIFF). If applicable, select an HDR file type for saving the
HDR image file (Radiance RGBE or OpenEXR). If you want to save only the Tone Mapping
results and not the 32-bit HDR image, check Remove generated HDR image after processing.

Click Naming Options to choose a naming strategy.

Y€ Start with Set Number or Start with Filename of first image in the set are the main
options. Start with Set number will yield long names such as:
SetO01Enhancer3from_IMG_3421.jpg. Checking Use shortened version will yield shorter
names that do not reference the source files: SetO1Enhancer.jpg, for example. Start with
Filename of first image in the set yields file names that start with the first image in the
set: IMG_3431_2_3Enhancer.jpg, for example. Suffix (optional) will append additional
file name information to the end of the assigned file names.
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Start Batch Processing

Click Run to start batch processing.

The window below the Run button will show the status of each process in real time.

> Loading 3 images starting from JEOO2712.JPG

> Aligning images...

> Generating HDRI from 3 LDR images

> Saving result as JEOO2712_1_O0HDR.hdr

> Processing HDR image with Details Enhancer...

> Saving result as JEOO2712_1_0Enhancer.jpg

> Processing HDR image with Tone Compressor...

> Saving result as JEOO2712_1_0Compressor.jpg

> Removing HDR file Volumes/USB DISK/Venice/
PhotomatixResults2/JE0O2712_1_0HDR.hdr

Combining 3 images using Highlights & Shadows - Auto

> Saving result as JEOO2712_1_0Auto.jpg

> Loading 3 images starting from JEOO2709.JPG

> Aligning images...

> Generating HDRI from 3 LDR images

> Saving result as JEOO2709 8 7HDR.hdr

> Processing HDR image with Details Enhancer...

> Saving result as JEOO2709_8_7Enhancer.jpg

> Processing HDR image with Tone Compressor... "
> Saving result as JEOO2709_8_7Compressor.jpg <
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4.2 Single File Conversion

Single File Conversion lets you batch tone map existing HDR image files or create pseudoHDR

images from single RAW files.

* Click on the Automate menu and select Single File Processing.

eon

CONVERSION OPTIONS

Barch Conversion of Single Files

f*} Tone Map HDR Image file(s) into  16-bit TIFF %) using. '?_?1 Deralls Enhancer
__ Tone Compressor

_) Convert RAW files into pseudo-HDR image saved as

: Remove watermark

SOURCE

carnival_expo0_-2_+2 hdr

/uwe pc master/doc manual writing/hdr

All filles listed on the right will be processed, unless you
select spacific Ales with your mouse

DESTINATION
Cancel
) Created under Source Folder —

_ Customized location

* Check the desired conversion option.

" Settings.

€ Run )

= Tone Map HDR image files: Processes HDR image files with Details Enhancer
and/or Tone Compressor. For Settings, read more in the Batch Processing section of

this manual.

= Convert RAW files to pseudo HDR-image: Creates HDR files in the format of your

choice.

= Remove watermark: This option is enabled with licensed versions of Photomatix
Pro. You can use it to remove the watermark from images that have been created
when using Photomatix Pro in trial mode. The removal can only work properly if the
size and brightness of the image have not changed after the watermark has been

applied.
e Select the source folder.
e Select the destination folder.

¢ Click Run.
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Section 5: Advanced Tips and Techniques

5.1 Chromatic Aberrations (CA)

Often you may see on your tone mapped or merged image artifacts like these:

CA shown in Photomatix Pro after merging
This is the result of chromatic aberrations (sometimes called fringing).

What are chromatic aberrations? Most lenses are not perfect and can sometimes focus the red,
green and blue channels on different planes (relative to the sensor). This can produce
green/purple fringes at higher contrast edges. The effect is stronger towards the corners than in
the center. Even top rated zoom and wide-angle prime lenses can show this artifact.

A tone mapped or blended image can show stronger chromatic aberrations than in the source
images. Careful inspection of the source images can reveal them.

Fortunately, some RAW converters like Adobe Camera Raw and Lightroom can help to fix
chromatic aberrations. Below, the correction of chromatic aberrations using Lightroom is shown.
The Lightroom Develop module has an extra function for removing chromatic aberrations.
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* Correct chromatic aberrations in all RAW files inside Lightroom

CA correction in Lightroom

Setting Defringe to All Edges can improve the correction.

* Copy (Synch) the chromatic aberrations settings to all RAW files that you will merge in
Photomatix Pro.

* Export all files as 16-bit TIFF files from Lightroom.

* Merge the images in Photomatix Pro with your method of choice (HDR + tone mapping
or exposure blending).

Here is the result in Photomatix using this workflow:

Fixed result
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5.2 Image Alignment

It is believed that using a tripod can avoid any mis-alignment of the photos. This is often not the
case because of:

*  Wind

* Shutter slap (even using mirror lockup)

* Shaky ground

This can be checked using a 200mm telephoto lens. It is surprising how much the exposures
can be out of alignment. The good news is that the Photomatix Pro alignment functions can
often properly align them. Photomatix supports two different alignment methods, based on
different algorithms. If one doesn’t work, the other should be tried.

Photomatix Pro User Manual Page 40



Section 4: Batch Processing

5.3 Processing RAW files in 3" party raw converters

If a RAW converter is used (e.g. Adobe Lightroom or Camera Raw), images should be
processed with the following settings:

*  WB (White Balance): Same WB for all involved photos.
* Basic settings: Should be all set to zero.

Auto

Sample Settings

e Curves: Both Parametric and Point Curves should be linear.

Highlights
Lights
Darks

Linear <
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5.4 Blurred Images

If bracketed images are merged and the resulting image is blurred, the reason can be one of the
following:

* Images are too far out of alignment and the image alignment functions cannot handle it.

* One or more images show motion blur due to too long shutter speed (even using image
stabilized lenses or a tripod). In this case, it is recommended that the individual images
are checked for motion blur.

5.51S0O and Noise

As the ISO value of your image increases, so does the noise in the shadows. Exposure
Blending can help reduce noise, but it is still a good practice to photograph at the lowest ISO
level possible.

5.6 Photomatix Pro and Color Management

Photomatix Pro supports color management even if RAW files are processed. It is
recommended that the same working space be used in Photomatix Pro as you use in other
image editors (e.g. Photoshop).

e 06 Photomatix Pro Preferences

3

General = Files  RAWSs

Default White Balance to  As Shot T]
sRGB
Default Output Color Space to v Adobe RGB
ProPhoto RGB

Demosaicing quality: NI

Pseudo-HDR from single Raw: @ Show note after converting

Photomatix supports the three most popular working spaces:

* sRGB: Used if your images are only created for the web.

* Adobe RGB: Popular working space for printing if extreme saturated colors are not
used.

* ProPhoto RGB: Extreme wide gamut working space. This should never be used for 8-
bit images.

For all JPEG and TIFF files Photomatix Pro preserves the color spaces of the source files.

Photomatix Pro User Manual Page 42



Section 4: Batch Processing

Resources

For more information, we recommend the Photomatix Pro FAQ on the HDRsoft website at
http://www.hdrsoft.com/support/faqg photomatix.html.
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